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Foreword 

This manual provides an introduction to the basic Process Engineer 
operations and functions. 

While developing these functions we have made every effort to create a 
clearly organized, easy-to-understand program structure. 

A user-friendly interface as well as a clear menu guide will enable you to 
quickly learn how to operate the program and to get familiar with its functions 
so that you can carry out your planning tasks in a quick and reliable way. 

Nevertheless, there will certainly be some things that we could do even better. 
If you have any suggestions for improving our software, please be sure to let 
us know. 

We look forward to receiving your constructive feedback. It helps us to make it 
even easier for you to work with the Process Engineer functions. 

The same holds true for the manual that you are now reading. If, at any point 
when using these instructions, you feel you are not being provided with the 
clear, unambiguous, and proper guidance necessary to work with this 
application, please be sure to let us know. We look forward to receiving your 
comments and tips. 

Please feel free to call, send us an E-mail, or contact our user hotline. 

 

Please Send your Suggestions to: 
 DELMIA GmbH 

 Raiffeisenplatz 4 

 D-70736 Fellbach 
 Phone:  +49/711/27 300-0 

 Fax:  +49/711/27 300-599 

 E-mail:  delmia.de.info@3ds.com 

 

User Hotline: 
If you have problems when using DELMIA products, please contact our user 
hotline at: 

 
 Phone:  +49/711/27 300-400 

 Fax:  +49/711/27 300-599 

 E-mail:  delmia.de.support@3ds.com 

 

No Liability or Guarantee 
Our programs and manuals have been compiled with great care and to the 
best of our knowledge. They have also been tested in a production setting. 
However, we assume no liability and provide no guarantee that the software 
and related descriptions are free of error or are suitable for special purposes. 

DELMIA assumes no liability for any damage that may arise from the use of 
this software. By using this software, the user acknowledges this exclusion 
from liability and shall hold DELMIA exempt from all claims. 

mailto:delmia.de.info@3ds.com
mailto:delmia.de.support@3ds.com
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Copyright 
The information in our documents may be copied and distributed for internal 
purposes provided it is done free of charge and the contents are not altered or 
distorted. 

Any other form of usage, especially the sale on CD-ROM or in any other 
publication in whole or in part is only permitted after prior written consent by 
DELMIA. 

Some parts of this software are owned by Unigraphics Solutions Inc. and are 
copyrighted © 2010. All rights reserved. 

Some parts of this software are owned by combit® GmbH and are 
copyrighted. Report-/Print module List and Label® Version 8.0: Copyright 
combit® GmbH 1991-2010. 

 

Modifications 
Moreover, DELMIA retains the right to make modifications and improvements 
to the product described in this manual at any time without prior notification. 

DELMIA and the 3DS logo are registered trademarks of Dassault Systèmes or 
its subsidiaries, in the United States or other countries. 

© 2001-2010 Dassault Systèmes - All rights reserved 

Thank you for your interest in our products 

 

DELMIA GmbH 
 Raiffeisenplatz 4 

 D-70736 Fellbach, Germany 

Phone: +49 (-400)711/27 300-0 

Fax: 49/711/27 300-599 
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1. Introduction 

This manual explains how to use the Process Engineer for your planning 
purposes. 

1.1 How to Use this Manual 

This manual enables you to get familiar with the operation and functions of the 
Work Positions. This manual briefly describes: 

 Main menus provided by the Process Engineer 

 How to start and exit the program 

 How to execute menu functions and how to navigate in views 

Note 

This manual provides the basis for all further program modules. You will find a 
more detailed description on how to work with these modules in the respective 
manuals. 

1.2 Documentation Conventions and Symbols 

The symbols used in this manual are intended to provide you with keys to the 
contents in an immediately understandable manner. 

 

This symbol is used to introduce key concepts that are covered in the sections 
immediately following this symbol. As a result, this symbol most frequently 
appears at the beginning of chapters or sections. 

Note 

This symbol is used to mark notes, which provide you with additional 
information you need to have for further work. You will either find the Note sign 
at the beginning of a chapter or in a particular text passage in the chapter. 
Texts bearing this sign are additionally marked with Note. The text is always in 
italics. 

Caution 

This symbol indicates that the text that follows describes particular 
circumstances that you must avoid to avoid potential errors with the operation 
of the program or harm to data. You will either find the Caution sign at the 
beginning of a chapter or near a particular text passage in the chapter. Texts 
that are introduced by this sign are additionally marked with Caution. The text 
is always in italics. 
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This symbol marks examples which serve to illustrate a certain situation. 

 

This symbol marks the individual operational steps involved in a particular 
operating instruction. Operating instructions describe operational steps, for 
example, how to open a menu or execute a function. 

 

This symbol marks listed subjects. The symbol for listed subjects can be either 
used to structure a continuous text or to list main subject keywords. 

 

This symbol marks list inside a bulleted or numbered list. 

 

This symbol marks cross reference information that is available in another 
manual. 

 

1.3 New Functions in General Introduction 

No new functionality has been added for this release. 

 

 

  
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2. Starting and Exiting 

The DELMIA Process Engineer can be started either from the start menu 
(Please refer to the Figure 1) or by double-clicking the appropriate icon on 
your desktop. To view the Process Engineer icon on your desktop link it to the 
desktop using the start menu. 

Once the program is started, you must log on with a user name. 

 

Figure 1: Starting the Process Engineer using the Start Menu or Icon 

2.1 Logging on the Process Engineer 

Enter your User Name and Password in the user login dialog box. Your 
password and user name are registered by the administrator. According to the 
user assigned rights, a user is given access to specific Process Engineer 
functions. The administrator, for example, has access to all Process Engineer 
functions and administrator is the only person who is authorized to create user 
names and passwords. Please refer to the Figure 2. 

 

Figure 2: User Authorization Dialog Box 

2.1.1 Entering the User Name 

1) Enter the user name (admin) in Name field and password (admin) in 
Password field. Always observe the upper/lower case as defined by the 
administrator Please refer to the Figure 2. 

2) Click OK. The Process Engineer opens the most recently opened project. 
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3) If the upper/lower cases have not been observed when entering the user 
name or password, a message appears. Please refer to the Figure 3. 

 

Figure 3: Login Failed Message 

4) When this message appears, simply click OK. Then enter again your 
password and user name. Make sure you type them correctly. You can 
repeat this procedure as many times as you want. 

2.1.2 Tools Menu 

The executable functions in the Tools menu are generally not available to the 
normal user. These functions can be executed only by a system 
administrator. 

 

Figure 4: The Tools Menu 

Server Tools 
The Server Tools monitor the IPD Server processes and manage information 
on the logged-on clients. The server tools are installed on master and slave 
servers. 

1) You can open the server tools either from the start menu or by double 
clicking symbol on the desktop. 
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Figure 5: Interface on Opening the Server Tools 

Setting Tool 
In the Setting Tool you can find the paths set when the Process Engineer was 
installed. The paths can be changed after installation, i.e. upon the failure of a 
computer or server on which the database is locally stored. The paths must 
then be changed to correspond to the new location where the database is 
stored. 

 

Figure 6: Setting Tools Dialog Box 

The Setting Tool dialog box is required for both new installations of the 
database as well as for updates. The standard settings are read from one file. 
Items are displayed as soon as they are available in the database. 

DBAssistant Tools 
The DBAssistant-Tool is used for installing the Oracle database. The data 
content and database structures are transferred upon both import and export. 
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In addition it is possible to align data with an upgrade and query as well as edit 
support information and Oracle information. 

Note 

The DBAssistant may be used only by a trained system administrator. 

 

Figure 7: Dialog - DBAssistant 

2.2 Saving Data Permanently in the Project Database 

To avoid any loss of data that have been created, changed, or added to a 
certain project, save the data permanently in the project database. 

2.2.1 Saving Project Data 

Project data can be saved in two different ways: 

 Using the menu 

 Using the appropriate icon in the toolbar 

Furthermore, you can enter a time interval for automatic saving. The automatic 
saving process is always running in the background. You find the Settings 
dialog box in the Miscellaneous tab of the Tools/Settings menu. The time 
interval is entered in minutes. By default, the Process Engineer automatically 
saves after every 10 minutes. Please refer to the Figure 8. 

 

Figure 8: Utilities Menu – Saving Data Automatically 

Saving Data using the Icon 
The two icons are available to save project data: 
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Figure 9: Save Data through Icon 

Use the Save icon to save transactions in the current window. This icon is only 
active if a transaction has been performed that is relevant to the saving 
process. Such transactions are creating new resources or changing data. 

If you use the Save All Transactions icon, all performed transactions are 
saved. For example, you may have opened and edited multiple views. This 
icon is always active. 

Saving Project Data using the Menu 
Using the File menu (Please refer to the Figure 10) provides another 
possibility to save project data. You can get the same result with icons also. 

 

Figure 10: Saving Data using the Menu 

If the Save All Transactions icon is inactive, you may have performed a 
transaction which is not relevant for the saving process or there may be no 
hierarchical level selected in the PPR navigator. The icon gets shaded Please 
refer to the Figure 11. 

 

Figure 11: Inactive Save Icon 

2.2.2 Exiting the Program 

When you are closing a project or exiting a program with newly generated, yet 
unsaved data, a program message prompts you to save the data. 
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Figure 12: Prompt to Save Changes when Closing an Application 

To exit a program, use the File menu or the Close button (cross symbol) in 
the title bar. Please refer to the Figure 10. 

2.2.3 Program Crash 

Note 

A program crash occurs when the entire hard drive space is used. If you have 
any technical problems with the application, please contact our hotline service 
team. (Please refer to the Foreword 

The original database condition must be restored after each program crash . 
Execute the ShutdownPPRServer program to ensure that all tasks that have 
caused the program crash are stopped. You can activate the 
ShutdownPPRServer program by using the start menu or the program icon 
on your desktop (Please refer to the Figure 13). To view the 
ShutdownPPRServer icon on your desktop link it to the desktop using the 
start menu. 

Note 

There is no saving process in the case of a program crash. Only the most 
recently saved planning situation is available after the crash. 

1) Activate the ShutdownPPRServer or ShutdownPPRClient before 
restarting the program after a crash. Please refer to the Figure 13. 

 

Figure 13: Executing ShutdownPPRServer 
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3. Views in the DELMIA Process Engineer
 
 

The display of views in the Process Engineer is based on Windows 
technology. If you are planning a digital factory, the Process Engineer 
provides you with multiple main views for specific use in individual modules of 
the program. A major benefit of the Process Engineer is the well structured 
presentation of these views. This helps you to navigate in a confident manner 
on all levels and quickly provides with the required results. 

This chapter gives you a brief overview of the most important Process 
Engineer views available for your work. For more detailed information on how 
to execute the different program modules, Please refer to the appropriate 
individual manuals. 

3.1 Main Views in the Process Engineer 

The Process Engineer provides you with the following views: 

PPR Navigator 
This view lists the basic procedures for the project you want to create. The 
PPR Navigator is a global program module which is used for all individual 
Process Engineer modules. The PPR Navigator displays and generates the 
project structure. For your work with the PPR Navigator, you get the three 
project views – Product, Process, and Resource View – as well as with a 
Project Library and a Plan Type Set. Please refer to the Figure 14. 

For more information on the PPR Navigator, Please refer to the PPR 
Navigator Manual. 

Product View 
This view creates and displays the products you want to edit for a specific 
project. The display is structured in a hierarchical way. The individual 
hierarchical levels correspond to a bill of materials structure. The Product View 
is only available in the PPR Navigator. Please refer to the Figure 14. 

For more information on the product structure, Please refer to the PPR 
Navigator Manual. 

Process View 
This view generates and displays the processes for a specific project. The 
display is structured in a hierarchical way. Unlike the Product View, the 
Process View allows you to open an additional view from the PPR Navigator. 
Furthermore, the Process View provides the user with additional functions. 
Please refer to the Opening Views from the PPR Navigator. 

For more information on how to generate and work with a process structure, 
Please refer to the PPR Navigator Manual and the Process Graph Manual. 

Resource View 
This view generates and displays the resources for a specific project. The 
display is structured in a hierarchical way. Like the Process View, the 
Resource View allows you to open an additional view from the PPR Navigator. 
Furthermore, the Resource View also provides the user with additional 
functions. Please refer to the Opening Views from the PPR Navigator. 

PPRNavigator.pdf
PPRNavigator.pdf
PPRNavigator.pdf
PPRNavigator.pdf
PPRNavigator.pdf
ProcessGraph.pdf
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For more information on how to generate and work with a resource structure, 
Please refer to the PPR Navigator Manual and the Manufacturing Concept 
Manual. 

Project Library 
The Project Library lists all data that are used for a project and which are valid 
only for this specific project. Changing these data will only affect the project at 
hand. Please refer to the Figure 14. 

For more information on the Project Library, Please refer to the PPR Navigator 
Manual. 

The System Library 
The Library is the location where system elements or Plan Type Sets are 
created. The Process Engineer uses the Library on a global basis i.e. the data 
are available for all projects. Please refer to the Figure 41. 

For more information on the Library, Please refer to the Project Library 
Manual. 

The General Search 
The General Search is used to quickly find and provide data. Please refer to 
the Figure 42. The General Search is equipped with specific search functions 
related to a project. 

For more information on the General Search and project-related search 
functions, Please refer to the Finder Manual. 

Minimising and Maximising Windows 
Use these arrows to minimize or maximize a window. The arrows indicate the 
direction in which you can adjust the size of a window. Furthermore, you can 
use the left mouse button to move the window bar individually until you have 
adjusted the required window size. 

3.2 PPR Navigator View 

The PPR Navigator  is divided into two windows. The left window shows the 
project structure along with the three structures – the Plan Type Set and the 
Project Library. The right window is the display area providing several tabs for 
display in the structure level to be selected. The display varies according to 
your selection: either you can get a list (as displayed in the Figure 14) or a 
Properties menu. Objects can be Processes, Resources, or Products. An 
object is the more general definition of structure levels. 

PPRNavigator.pdf
ManufacturingConcept.pdf
ManufacturingConcept.pdf
PPRNavigator.pdf
PPRNavigator.pdf
ProjectLibrary.pdf
ProjectLibrary.pdf
Finder.pdf
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Figure 14: General Structure of the PPR Navigator View 

3.2.1 Navigating Views and Opening Menus 

The PPR Navigator can be defined as the general control centre of the 
Process Engineer. It is the starting point for most of the transactions in the 
Process Engineer that are to be performed in the individual program modules 
as the three-dimensional presentation of production lines or workstations, the 
definition of location premises or also for the planning process of a production 
concept. 

The basic Process Engineer functions and operations can be summarized in 
three items: 
 Applying Mouse Techniques: Please refer to the Getting Familiar with the 

Mouse. 

 Opening the Process or Resource View: Please refer to the Opening Views 
from the PPR Navigator. 

 Working with Menus and Context Menus: Please refer to the Working with 
Menus. 
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3.2.2 Getting Familiar with the Mouse 

To use all Process Engineer functions in the simplest possible way, you 
should have a scroll wheel mouse with three keys. 

Applying Mouse Techniques 
The mouse is one of the most important tools for your work in the DELMIA 
Process Engineer. Hold the mouse in your hands during all operations to 
choose options from the menu or to click buttons – buttons are usually used to 
start program functions – you can also use the mouse when working with 
context menus. Mouse is generally equipped with three operational keys – the 
left, centre, and right mouse button. 

Using the Left Mouse Button 
You normally use the left mouse button for operation. If no other mouse button 
is explicitly mentioned, always use the left key. 

For left-handed users, the left mouse button function may be transferred to 
another key. In this case, the functions are assigned in a mirror-inverted order. 

You can use the mouse button in order to: 

 Open menus 

 Select options 

 Activate dialog boxes and input fields 

 Highlight entries 

 Start program functions using buttons 

Using the Centre Mouse Button or the Scroll Wheel 

The mouse wheel can be used like a key. You may operate the zoom function 
in a three- or two-dimensional view. You may also use the scroll wheel to 
display the complete contents from an open view. Normally, the view is 
additionally equipped with scroll bars. 

Using the Right Mouse Button 
The right mouse button is mainly used to open context menus. Context menus 
offer operational options in addition to the function currently activated. 
Double-Clicking 
You can use the mouse to double-click to start the Process engineer via the 
icon on your desktop or to restore the original size of a minimized window. 
Double-click means: clicking twice on an object with almost no time between 
the two clicks. Double clicks are always made with the left mouse button. 

3.2.3 Using the Center Mouse Button in a Graph 

Using the center mouse button, you may navigate without limit vertically and 
horizontally in a graph (as of PE 5.15). There is no limitation anymore, such as 
that navigation is possible only to cell 282 when the zoom is set to 100%. 

To Activate the Scroll Function 

1) Click the graph with the center mouse button. The arrows indicate the 
current direction of motion. You can navigate in eight directions. 

Center 
mouse button 
is activated. 
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2) Navigate in the graph (horizontally or vertically) to achieve the desired 
view. 

3) To deactivate the scroll function, click graph with the left mouse button. 

 

Figure 15: Navigating in a Graph 

3.2.4 Using Drag and Drop 

You can execute three functions in the Process Engineer by drag and drop: 

 Copy and paste 

 Move 

 Creating a reference 

Copy and Paste 
Copied objects remain in the source location and are copied to a target 
location. 

In the Process Engineer you can 

 Copy objects within the same structure 

 Copy objects between different structures 

 Copy objects between projects with the same plantype set 

Drag and Drop behaves similarly for all copy processes. You can learn more 
about the behavior of drag and drop on two examples – copying within a 
structure and between two projects. 

In order to copy objects, press the left mouse button (standard assignments 
for mouse buttons) and the control key. 

Copying within a Structure 
1) First select the object you want to copy – in Figure 16 the variant New 

Variant 1 is selected. 
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2) Press control key and hold until the object to be copied is added to the 
target location. 

3) During the copy process, the appearance of the mouse pointer changes so 
that you can immediately see that a copy process is taking place 

 

Figure 16: Copying by Drag and Drop within a Structure 

4) You can then stop pressing the mouse button and the control key. Now 
you must confirm two messages. 

5) Confirm the message with OK. The message shows that a copy process is 
to be executed. 

 

Figure 17: Execute Copy Message 

Determine whether only the selected object (normal) is to be copied or the 
structure of the object (deep) is also to be copied. 

 

Figure 18: Type of Copying – Normal and Deep 

Confirm the message and the object is copied. (Please refer to the Figure 16 
for copying of the New Variant 1). 

Hiding the Copy Options Dialog Box 
The customer_related entries enables you to determine if the Copy Options 
dialog box should be displayed during the copying process (Please refer to the 
Figure 18). 

 If the value is set to one, the dialog is not displayed during the printing 
process. 

 If the value is set to zero, the dialog is displayed during the printing 
process. 
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Figure 19: Set the Value – Hide the Copy Options Dialog Box 

For more information on global settings, Please refer to the Settings Manual. 

Copying between two Projects 
It is possible to copy objects between two different projects by drag and drop 
in the same way as one does within a project. 

Copying between two different projects is possible only if both projects use the 
same plantype set. You can copy single objects as well as entire structures 
(partial projects). Moving and referencing between two projects is not 
possible. 

Note 

When copying between two projects, time analyses in the source project are 
not copied to the target project – when copying partial projects. However the 
assigned rights of objects are copied. 

 

Settings.pdf
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Figure 20: Copying Between Two Projects – Same Plantype Set 

Translate 
When objects are moved, they do not remain in the source location; they are 
moved to another location (target). 

In the Process Engineer you can 

 Move objects within the same structure 

 Move objects between different structures 

 Drag and Drop behaves similarly for all move processes 

In order to move objects, press the left mouse button (standard assignments 
for mouse buttons) and the Alt key. 

Moving within a structure is demonstrated in the example given below: 

1) Moving follows the principle of deleting (source) and inserting (target). 

2) First select the object you want to move – in the example, Copy of car 
body is selected. 

3) Press the Alt key and keep it hold until the object to be moved is added to 
the target location. 

4) During the move process, the appearance of the mouse pointer changes 
so that you can immediately see that a move process is taking place. 
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Figure 21: Moving by Dragging and Dropping Objects 

5) Release both the mouse button and the Alt key. You must now confirm a 
message. 

6) Confirm the message with OK. The message shows that a move process 
is to be executed. Please refer to the Figure 21 for copying of the 
Karosserie. 

 

Figure 22: Execute Move 

Creating a Reference 
References are created in order to make other usages of a single object 
possible. Other usages of objects means that all objects always have the 
same properties: changes to one of the referenced objects apply to all objects. 
Please refer to the Figure 25. 

Referencing objects is different from copying in moving, in which objects can 
continue to be edited independently and have no further reference to the initial 
situation (at the source location). 

System elements of the system library are referenced exclusively – for 
example when a system element is linked to an object of the resource 
structure. 

Referencing 
Referenced objects remain in the source location and are copied to a target 
location. In the Process Engineer you can: 

1) Reference objects within the same structure 

2) Reference objects between different structures 

3) Reference objects between system elements from the system library and 
objects in the PPR Navigator 

Drag and Drop behaves similarly for all processes. In order to reference 
objects, press the left mouse button. No additional keys are required for 
referencing. 

Referencing within a structure is demonstrated in the example. 
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1) The referencing of objects follows the principle of copying (source) and 
inserting (target), and the reference to the source object is maintained. 

2) First select the object you want to reference – in the example the car body 
subassembly is selected. 

3) Press left mouse button and keep it held until the object to be referenced is 
added to the target location.  

4) During the referencing process, the appearance of the mouse pointer 
changes so that you can immediately see that a reference is being 
created.  

5) The corresponding structure is also copied, in contrast to copying and 
moving. 

 

Figure 23: Referencing by Dragging and Dropping Objects 

6) Release the left mouse button. You must now confirm a message. 

7) Confirm the message with OK. The message shows that a reference is to 
be created. The target object is referenced by the object source. 

 

Figure 24: Execute Link (Create Reference) 

Referenced objects do not lose their reference to the source object. If you 
change the names of the source or target object, the change will 
immediately be executed for both objects. 

If you delete a referenced object, all corresponding referenced objects are 
deleted. 
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Figure 25: Example: Name Changed – Linked Object 

3.2.5 Opening Views from the PPR Navigator 

To execute further functions  for process or resource structures, the Process 
Engineer provides individual views for these two structure types, i.e. the 
Process View and the Resource View. Both structures are generated in the 
PPR Navigator. The Product View does not require an additional view, as all 
functions are executed by the PPR Navigator. 

PPR Navigator views are opened using the context menu (Please refer to the 
Figure 26) of the right mouse button. Views can be opened from any 
hierarchical level of the structure currently selected, i.e. process or resource 
structure. 

To Open a View 

Note 

The procedure is the same for both structures. For example, you can move to 
the Process or Resource View, if you want to create or edit a process graph or 
a manufacturing concept. 

1) Select the hierarchical level you want to work with from the appropriate 
PPR Navigator structure. 

2) Select Open in from the context menu. 
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Figure 26: Opening Views from the PPR Navigator 

3) Select the view you want to open (here: the process engineer). 

The basic settings allow you to define whether you want the view to be firmly 
linked to the PPR Navigator or whether you want the view to be available as a 
separate window to be edited. The Figure 27 shows a situation where a firmly 
anchored structure has been chosen as a basic setting. The range of functions 
is the same for both settings. Depending on your personal preferences, you 
may choose either of two methods for window presentation. 

 

Figure 27: Open Resource and Process Views in a Firmly Anchored Structure 

Navigating Horizontally and Vertically 
Horizontal navigation (Please refer to the Figure 26) in the Process Engineer 
means to open views from the PPR Navigator. Vertical navigation in the 
Process Engineer means to open (Please refer to the Figure 28) process 
structures. Thus, horizontal and vertical navigation describe the work direction 
used between individual program modules or global functions such as the 
Search (Finder) or the (System) Library. 
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To Open and Close Structures 

To navigate horizontally or vertically, you can use (Please refer to the Applying 
Mouse Techniques) the mouse. 

1) Click the plus symbol in the structure. As a result, the next hierarchical 
level gets open. 

2) Click the minus symbol in the structure. As a result, the opened 
hierarchical level gets closed. 

 

Figure 28: Opening and Closing a Structure 

3.2.6 Closing Views 

The closing procedure of a view that has been opened from the PPR 
Navigator, i.e. Process View or Resource View depends on the selected 
settings. There are two possibilities for your work with views: 

1) Either with a firm link to the PPR Navigator 

2) Presenting views without any link 

You can define this setting in the dialog: Select Clients should appear as a 
Docking View from the Browser and Menu Items tab in the Tools/Settings 
menu. Please refer to the Figure 29. Both views linked to the PPR Navigator 
get displayed. 

 

Figure 29: Presenting Views in a Lose or Fixed Structure 

Note 

You cannot use the Close button (cross symbol) to close a view that is firmly 
linked to the PPR Navigator. Views can only be closed using the File menu. 
Please refer to the Figure 30. 

Closing Views Firmly Linked to the PPR Navigator 
If you work with a display structure that is firmly linked (anchored) to the PPR 
Navigator, use the File menu to close an open view, i.e. Process or Resource 
View. 

You can only close an open view that is currently selected from the application 
range. Please refer to the Figure 14. 
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Then select Close from the File menu. As a result, the open application gets 
closed. 

 

Figure 30: Closing a Firmly Anchored View – using the File Menu 

Closing Views that are not Linked 
Views that are not firmly linked to the PPR Navigator provide different options 
to close a Process or Resource View: 

1) Using the menu 

2) Using the Close button (cross symbol) in the title bar 

3) Using the Windows menu 

4) Select the view you want to close 

 

Figure 31: Resource View – not Firmly Anchored 

The icon for window selection is only active if the views are not firmly linked 
to the PPR Navigator or if additional functions such as the Search (Finder) or 
the (System) Library have been activated. 

When you activate this icon in the toolbar, the Windows dialog box opens 
where all open functions and views are displayed. 
To Close a View or Function 

Select the required view from the dialog. Then click Close Window(s). The 
selected view gets closed. 
To Activate a View or Function 

Select the required view from the dialog box. Then click Activate. The 
selected view gets displayed in the foreground on your screen. Please refer to 
the Figure 32. 
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Figure 32: Windows Dialog with Open Views 

3.3 Display Area 

3.3.1 Specifying Individual User Settings 

Any one can arrange column headings according to the specific needs. This 
arrangement remains unchanged until the administrator specifies a new 
arrangement of column headings. 

To Arrange Column Headings Individually 

1) Left-click the column heading you wants to rearrange in the display area. 

2) Move this column heading to the new position. 
3) Release the left mouse button. Please refer to the Figure 33. 

 

Figure 33: Rearranging Column Headings 

4) The column heading has now changed its position. Refresh the view. 

 

Figure 34: Example – Individually Arranged Column Headings 

5) Save these settings as usual. 

3.3.2 Sorting Column Headings by Plantype 

At the beginning of a project, the default settings which have been specified by 
an administrator with super user rights are available in the display area. 

The arrangement of column headings in the display area can be changed by 
locally in the project. For this purpose, there is no need for any super user 
rights. Thus, everyone has the possibility to customize the work environment 
shown in the display area according to his specific requirements. This means, 
that locally, user rights and administrator rights are identical. 
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Note 

An administrator with super user rights is allowed at any time to delete 
column headings that have been individually arranged by a user. He can 
assign new default settings. This may be the case, for example, if a 
standardized solution is expected to yield better results or if there are plans to 
completely redesign the display area. 

Column headings can be sorted for a specific plantype in the display area 
(called Listview in the information below). Only the Administrator may set up 
the default settings for sorting column headings.  

This arrangement of column headings by specific plantype in a Listview can 
then be accessed by all other users within the project. Please refer to the 
Specifying Default Settings by the Administrator. 

Specifying Default Settings by the Administrator 
To provide all users with default settings, the administrator saves all users in 
the Database via the Store List Properties function after the column 
headings have been arranged. 

 

Figure 35: Example of Column Headings Arranged by the Administrator 

The two functions Store list Properties and Delete Customer Settings may 
only be executed by an Administrator. 

 

Figure 36: Tools menu – Store List Properties 

When the column headings have been arranged, click Store List Properties 

in the Tools menu. 

To distinguish this column arrangement by the administrator, the column 
arrangements of the respective users are stored in the registration editor. 

Refreshing the Listview 
After storing, refresh the Listview to ensure that the new column arrangement 
is active. Please refer to the Figure 38. 

 

Figure 37: Example – Newly Arranged Column Headings 

Select the project node and then press the F5 Key or select Reload in the 
context menu of the project node. Please refer to the Figure 38. 
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Figure 38: Refreshing the List View 

3.3.3 Deleting Plantype-Specific Column Sorting 

Again, only the Administrator may delete the default plantype-specific sorting 
arrangement. 

Note 

The menu item Tools/Delete customer settings is omitted from the Version 
PE 5.12. The entries are now deleted in the new dialog box 
Tools/Settings/Maintenance. 

3.3.4 Copying the Display Area onto the Clipboard 

Only the selected lines get copied onto the clipboard. 

1) With the help of the Control key + A shortcut, all objects in the list are 
selected. 

2) You can select individual objects by pressing the Control key and the left 
mouse button. 

3) You can select all the intermediate objects by pressing Shift key and the 
left mouse button. 

4) Select one or several elements in the display area and open the context 
menu. 
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Figure 39: Context Menu: Copy to Clipboard 

5) Select the entry Copy to Clipboard. The selected lines get copied onto 
the clipboard. The entire display area is copied to the clipboard. 

In order to continue to use the content of the clipboard, open Microsoft Excel 
and select the entry Insert in the menu Edit. 
The content of the clipboard is copied to Microsoft Excel. Please refer to the 
Figure 40. 

 

Figure 40: Example for Paste Data from the Clipboard 

3.3.5 Library View and Search View 

Library View 
The (System) Library can be used for any project on a global basis. 
The Library can be opened using the appropriate icon in the toolbar or using 
the File menu.  
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The Library is described in more detail in a separate manual. Please refer to 
the System Library Manual. 

 

Figure 41: Library in the Process Engineer 

Search View 
The Search within the Process Engineer is an elegant means to quickly find 
and provide data. 

The General Search function can be opened using the appropriate icon in the 
toolbar or using the Edit menu. 

The General Search function is described in more detail in a separate manual. 
Please refer to the Finder Manual. 

 

Figure 42: General Search Display 

SystemLibrary.pdf
Finder.pdf
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3.4 Working with Menus 

The Process Engineer provides three basic menu types: 

 Main menus in the menu bar 

 Right mouse button context menus 

 Function dialogs 

This section of the chapter provides you with an introduction to basic 
operations of the different menu types. For project-related information on 
menus and functions, Please refer to the respective manuals. 

3.4.1 Main Menus 

The main menus are used to activate the basic functions in the Process 
Engineer. The main menus can be opened from the menu bar. 
These three symbols in the title bar are used to minimize, close, or maximize 
the current window. 

 

Figure 43: Menu bar Featuring the Main Menus 

File Main Menu 
This menu can be used to (Please refer to the Figure 44) open a new project, 
to save a project or to exit the Process Engineer. This menu is mainly used for 
project-related work. 

 

Figure 44: Functional Range – File Main Menu 

Activating Menu Functions 
Perform the following steps to activate functions from a main menu: 

1) To open a main menu, select the required menu from the menu bar 
(Please refer to the Figure 43). To do this, use the left button of your 
mouse to click the required menu item. 

2) To activate a function in the main menu, select the required function from 
the main menu. To do this, use the left button of your mouse to click the 
selected function. 
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3) If you want to activate a function along with additional functions please 
select another function from the menu. These functions are also marked 
with an underscore in the main menu. 

4) Move your cursor (Please refer to the Figure 45) to the additional menu 
and left-click on one of the functions offered. 

 

Figure 45: Functions with Additional Functional Range 

Edit Main Menu 

You can use this menu (Please refer to the Figure 46) to copy transactions 
from a project, to open properties of a selected object or to assign specific 
access rights for objects. Furthermore, you can start the General Search. You 
can also use this menu for any specific, project-related work. 

 

Figure 46: Functional Range – Edit Main Menu 

Tools Main Menu 
You can use this menu (Please refer to the Figure 47) to define the basic 
settings for the Process Engineer, to select print forms, to delete a project, or 
to import data. Moreover, the Database Utilities menu item provides you with 
configuration utilities and the user management. This menu is mainly used for 
general work in the Process Engineer that is not related to a specific project. 
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Figure 47: Functional Range – Tools Main Menu 

View Main Menu 
You can use this menu (Please refer to the Figure 48), to show and hide the 
toolbar or the browser window. You can mainly use this menu to provide 
different views for your work with the Process Engineer. 

 

Figure 48: Functional Range – View Main Menu 

Help Main Menu 
You can use this menu (Please refer to the Figure 49) to access any available 
manuals from the program. You can mainly use this menu whenever you need 
help on a specific subject. The yellow question mark provides you with 
updated information about the currently installed Process Engineer version. 

 

Figure 49: Functional Range – Help Main Menu 

3.4.2 Function Menus for Program Functions 

Note 

In addition to the main menus shown, the Process Engineer provides further 
menus. These menus are only available for specific functions of a program, 
such as when working with graphic or camera tools. 

Function Menu – Graphic 

This menu is available only when you edit a graphic. 
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Figure 50: Functional Range – Graphic Function Menu 

3.4.3 Context Menus, Dialogs, and Properties Menus 

In addition to the hierarchical level selected, a context menu provides 
functions that you may require or use for your current work process. Dialogs 
either provide displays for a specific subject or you can enter data in these 
dialogs. Properties menus define data for a specific object, i.e. for a project. 

Opening Context Menus 
Context menus are accessed using the right mouse button. 

 

Figure 51: Opening a Context Menu using the Right Mouse Button 

To Open a Context Menu 

1) Use the left mouse button to select the hierarchical level from where you 
want to open the context menu. 

2) Press the right mouse button. 
3) The context menu opens. Please refer to the Figure 51. 



Views in the DELMIA Process Engineer 32 

General Introduction  Version PE 5.19 

4) To activate the functions provided in the context menu, left-click one of the 
available functions. 

Dialogs in the Process Engineer 
All program modules provided by the Process Engineer use dialogs in the 
context of currently used functions. The following two examples illustrate the 
use of dialogs. 

Example of a Display – Find Usage 
This example shows the usage of the selected Resource View. The individual 
tabs provide you with further information. The tabs may change with each 
dialog or also with a selected hierarchical level. 

To obtain information about a specific tab, Left-click a tab to view the tab 
information required. 

 

Figure 52: Find Usage – Resource View 

Example of Entered Information – User Management 
The User Management dialog allows you to enter data, for example, to create 
a new user or to delete a user. For more information on user management, 
Please refer to the Administrator Manual. 

The following functions of this dialog are executed by the administrator: 

 To create a new user, you must open the User menu. 

 To assign rights, you must open the Rights menu. 

 

 

Administration.pdf
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Figure 53: Editing the User Management 

Opening Properties Menus 
The Properties menu is available on almost all hierarchical levels. Properties 
menus are accessed using a context menu (Please refer to the Figure 51) of 
the selected level. The following example illustrates the use of a Properties 
menu. 

Project Properties Menu – General Tab 
Tabs may vary for each Properties menu. Tabs are provided according to the 
hierarchical level selected. 

The General tab defines general Properties data. In our example, these 
Properties data relate to the current project. 
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Figure 54: Project Properties Menu – General Tab 

Project Properties Menu – Filter Tab 
The Filter tab defines filter information. This is helpful, for example, if you want 
to view a display that has been selected according to special filter criteria. 
Filters can be coderules, production numbers, or coderule macros. The Filter 
tab is only available in the Project Properties menu. 

 

Figure 55: Project Properties Menu – Filter Tab 
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Project Properties Menu – Boundaries Tab 
The Boundaries tab defines information about the workers, production 
processes, and the papers required. This information applies to the entire 
project. The Boundaries tab is only available in the Project Properties menu. 
The boundaries tab in project properties is hidden by default. 

 

Figure 56: Project Properties Menu – Boundaries Tab 

Project Properties Menu – Notes Tab 
This tab is virtually the subject heading of the Properties menu. The Notes tab 
allows you to write important information concerning the Properties. The 
information you type in this field only makes sense if it corresponds to a 
subject from the hierarchical level selected. In our example, this applies to any 
project-related information. This tab is available for all Properties menus. 

The context menu allows you to change the size, font, or color of the 
characters used. 

To do this, highlight the typed text and press the right mouse button. 
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Figure 57: Project Properties Menu – Boundaries Tab 

Using the Next and Previous Buttons in the Properties Dialog 
With the help of both the Next and Previous buttons of an opened properties 
dialog, you can display and even change the properties of PPR-components in 
another opened structure. 

By using this procedure with the help of the opened properties dialog you can 
move forward or go back in an opened structure. The PPR-component 
properties that you move to are always the ones that are displayed. The PPR-
component with the properties dialog that was opened first remains selected. 

1) Open up a structure in the PPR-Navigator. 

2) Select a PPR-component in the structure – Process 002 in the example. 

 

Figure 58: PPR Component 

You can open the properties dialog via the context menu. 

Admini
stratio
nR18_
eng 



Views in the DELMIA Process Engineer 37 

General Introduction  Version PE 5.19 

 

Figure 59: Example – the Properties Dialog of a Process 

3) Click Next button – the properties of the Process 002 are displayed. If you 
want, change the displayed properties of the Process 002. 

4) You can save any changes without closing the properties dialog box. 
5) Confirm the message with OK in order to save the changes. This message 

appears only if you have made changes. Please refer to the Figure 60. 

 

Figure 60: Save Changes Message 

3) If you want to display the properties of the previous process, click 
Previous button. 
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